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LogIT Explorer

Dundee City Council Educational Development Service
The aims of the INSET are.

· To raise teachers’ confidence in using ICT in science

· To demonstrate the capabilities of the LogIT Explorer

· To give teachers the opportunity to undertake basic activities using the Explorer

· To identify opportunities within the 5-14 science programme where the use of the LogIT Explorer will enhance pupils’ learning.
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Licence

· The software licence supplied through the Dundee primary schools bulk purchase is a single user licence.

· An unlimited site licence (£39.95) may be purchased from the manufacturer DCP Microdevelopments Ltd, (Note new address) Byron Court, Bow Street, Great Ellingham, Norfolk, NR17 1JB, Tel: 01953 4578000

· Software updates may be downloaded from http://www.dcpmicro.com/
Set Up 

· Insert four alkaline AA batteries into the LogIT Explorer.

· If the software is installed on a server only one datalogger may be used at a time otherwise the software will not recognise which data logger is providing the input. 
It is therefore strongly recommended that the software should be installed on individual hard drives.

· Only authorised personnel can do this, seek advice from your ITCO.

· Since some screen savers can interrupt continuous datalogging it is recommended that screen savers should be turned off when using the LogIT Explorer.

· Do not plug the LogIT Explorer into the USB port until the installation of the software is complete.

· Follow the instructions in the “LogIT Data Logging system instruction manual” pages 2 -3

· Problems: see page 9 of the LogIT Explorer manual.

· The LogIT Explorer will switch off the display to save the battery when recording for long periods. However it has been found that if the Explorer has been used connected to the computer and then the computer has been switched off and the USB cable left connected the batteries are drained overnight.

· To prevent accidental switching on during storage it is suggested that the Explorer is stored upside down in its case to prevent accidental pressure on the buttons. (Any of the three buttons will activate the Explorer.)
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When starting the Blue button is used to scroll through the menu.

When logging the Blue button provides a help function but does not interrupt the logging process.

What can it do?

1. Sense the following

· Temperature (internal & external sensors)

· Light (internal sensor & fibre optic cable)

· Sound (internal sensor)

· Voltage (external sensor)

· Pulse rate (external sensor)

· pH, a measure of acidity, (external sensor)

2. Control simple devices such as bulb, buzzer and motor

· External unit required

3. Measure time

4. Measure speed

5. Operate in various modes

· Stand alone 
Direct readings are displayed on the inbuilt display.

· Remote logging
Data is recorded continuously over time and stored in the Explorer’s memory.
Data may be retrieved when connected to the computer.
The last four sets of data are stored.

· Snapshot logging
Remote from the computer one set of readings is recorded in the Explorer’s memory every time the green button is pressed.
Data may be retrieved when connected to the computer.
The last four sets of data are stored.

· Real Time (live) logging
The Explorer is connected to the computer which displays sensor data live on the screen.

6. Display 

· Explorer has a display to show sensor readings and to present menus for setting up. 

· As a meter it displays all three sensor readings simultaneously complete with their calibration units. However, to simplify the display for younger pupils one or two of the sensors may be ‘switched off’ by inserting a 3.5 mm stereo jack plug into the appropriate external sensor socket.

· When connected to a computer, it can display from one to three sensor readings in meter, graph or data table format.

7. Software Levels

· The software is available at 4 levels of sophistication. You may wish to consider loading shortcuts to only the most appropriate level in a particular class.

· LogIT Lab Level 1 is the simplest and LogIT Lab Manager is the same as Level four plus facilities to manage the system.

· Managers Options are available from any level by pressing the key combination CTRL, ALT, SHIFT and T together.

Getting Started

A
Stand alone
Direct readings are displayed on the inbuilt display

1. Press the green button once.
Ignore the instruction to press the blue button once for the menu.
2. The display screen now shows, from left to right
temperature in degree Celsius
light level in lux
sound level in decibel

3. The screen also shows, at the left, a battery condition indicator (top) and the mode of operation indicator (bottom). The letter M indicates meter mode and this indicator changes to L when logging and T when timing.





4. Pupils could record the readings in a table.

5. Point the Explorer in different directions and observe the changes in readings.

6. What are the advantages and disadvantages of using this method?


	Advantages
	Disadvantages

	
	


7. After a few minutes you may notice that the display turns off. To avoid this press and hold down the green button for four seconds when switching on.

8. To avoid information overload with young pupils data on the display from unwanted sensor(s) could be masked using a sticky label or tape. An alternative is to insert a 3.5mm stereo jack plug into the external socket(s) this will stop the appropriate sensor(s) from working.

B
Remote logging

Data is recorded continuously over time and stored in the Explorer’s memory.

Four sets of data may be stored.

Data may be retrieved when connected to the computer.

1. Switch on using the green button.

2. A prompt’ Push Blue button for menu’ will appear and then the display will show the readings for the three sensors.
Press the Blue button once to see the menu.
It should read, ’Press Green to start logging’

3. Press the green button once to start logging. 
The message ‘Logging started’ will appear.
(If you delay pressing the button the display will show the readings of the sensors and a small letter M in the bottom left. You may press the Green at any time to start the logging. When logging, the symbol changes to a flashing L. You may also press the Blue button to see the menu.)

4. Take the Explorer for a walk around the room/building to collect data.

5. To stop logging press the red button.
A message ‘Logging stopped’ will appear and the display will show ‘M’ in the bottom left corner.

6. Pressing Green again will start a second phase of logging. The message ‘Logging started’ will appear. The first set of data will be retained.
Explorer can store up to four sets of data in its internal memory.

7. At this point the Explorer could be switched off and the data transferred to the computer later or the Explorer could be used in another mode buy pressing the Blue button. Further details below.

C
Snapshot logging

Remote from the computer one set of data is recorded in the Explorer’s memory every time the green button is pressed.

Four sets of data may be stored

Data may be retrieved when connected to the computer.

1. Switch on using the green button.

2. A prompt’ Push Blue button for menu’ will appear and then the display will show the readings for the three sensors.
Press the Blue button twice to scroll the menu.
It should read, ’Press Green to start snapshot’

3. Press the green button once to start logging. 
The message ‘Logging started’ should appear.
(If you delay pressing the button the display will show the readings of the sensors and a small letter M in the bottom left. You may press the Green at any time to start the logging. When logging the symbol changes to a steady L. You may also press the Blue button to see the menu.)

4. Take the Explorer for a walk around the room/building to collect data. To store sensor readings at a particular location press the green button. 
The message ’Storing readings’ should appear.
Collect readings at several locations.

5. To stop logging press the red button. The message ‘Logging stopped’ should appear. The display will show current readings for the three sensors and the symbol M should be in the bottom left corner.

6. At this point the Explorer could be switched off and the data transferred to the computer later or the Explorer could be used in another mode buy pressing the Blue button.

D
Viewing the collected data

Transferring data which is stored in the Explorer to a computer.

1. Connect the Explorer to the computer using the USB cable.

2. For this exercise, select LogIT Lab (level 1) from the Start Menu’s Programs List.

3. The Select New Activity window will appear.
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4. The top part of the menu shows the equipment currently detected and shows the battery condition. The lower half shows the seven main activities. Those not available are shown in grey text. (In this case the ‘Set Up’ option.)

5. Click on the ‘Fetch’ button to retrieve data which is stored in the explorer.

6. A small window will open up. Select File B which is the first set of data which you collected in remote (continuous) mode.
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7. A screen similar to that shown below but with three colour coded graphs will appear.
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8. One or more of the sets of data may be hidden from display by clicking the appropriate sensor information box(es) at the top right.

9. Using ‘Title’ from the ‘Edit’ menu it is possible to add a title to the graph.
Add the title ‘MY GRAPH’ to your graph.

10. The small icon 

	1
	2
	3

	4
	5
	6


in the toolbar will display the data table (from which data may be cut and pasted into a spread sheet if desired).
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11. The graph or data table may be printed from the ‘File’ menu.

12. Click ‘New’, bottom right, do not save and ‘Fetch’ the data from the second experiment.
Remember that this is data set A the (newest).

13. Notice this time the snapshot data is displayed as bars.
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14. Click the magnifying glass in the tool bar to expand the vertical scale.

E
Real Time (live) logging

The Explorer is connected to the computer which displays sensor data live on the screen.

1. Collect a cup of cold water.

2. Connect the Explorer to the computer using the USB cable.

3. For this exercise, select LogIT Lab (level 2) from the Start Menu’s Programs List.

4. Connect the external temperature probe to the Explorer in socket 2.

5. The Select New Activity window will appear. Notice that two thermometers are shown in the top half of the window.

6. Click ‘Autolog’.
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7. Uncheck the Sound sensor information box, top right.

8. Click the Start button: there are two available, one in the toolbar and the other bottom right. (It is possible to check and uncheck any of the sensors while logging is in progress. This action affects only the display. Data is recorded on all three channels unless a jack socket is inserted.)
(At level three, and above, there are many options to alter the display and to edit including selecting the number of decimal places displayed.)

9. Place the external temperature probe into the cup of cold water. (Make sure that the cup does not tip over.) 

10. Wait for the minimum temperature to be indicated. This will probably take about 15 seconds. (All types of temperature probe and conventional thermometers take time to register the correct temperature.) This problem can be avoided in pupil experiments by writing the instructions such that the temperature probe is inserted into the liquid as the first step before the software functions are selected.

11. Remove the temperature probe from the cold water and hold the end of the external temperature probe between your thumb and finger. Continue the experiment for about one minute.
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12. Investigate some of the options from the pull down menus.

13. NB for live logging in snapshot mode click ‘Snapshot’ at step 6

F 
Saving a File to Disk

1. When the datalogging exercise is complete select ‘Save’ from the ‘File’ menu or the shortcut ‘Ctrl S’ and use the dialogue box to save the file in an appropriate location.

.
G 
Loading a File from Disk

1. Launch LogIT Lab and click ‘Open’ from the Select New Activity Menu’

2. If LogIT Lab is open select ‘Open’ from the File menu.

H
Measuring Time
This is an expensive stopwatch!

1. Switch on using the green button.

2. A prompt’ Push Blue button for menu’ will appear and then the display will show the readings for the three sensors.
Press the Blue button three times to see the menu.
It should read, ’Press Green to measure time’

3. Press the green button once to start timing. 
The display shows the Time interval in seconds.
A small letter T is shown in the bottom left. 

4. To stop timing press the Green button again.
The display will read Time interval 1.99 seconds.

5. Press the Green button to time another interval and Green a second time to stop timing.

6. The factory default setting is for a maximum period of 30 seconds. This may be altered by using the Manager version of the program.

I
Measuring Speed
This is a extremely useful function. An object, with a piece of card 10cm long attached, is made to pass between the Explorer and a source of light.

1. Switch on using the green button.

7. A prompt’ Push Blue button for menu’ will appear and then the display will show the readings for the three sensors.
Press the Blue button four times to see the menu.
It should read, ’Press Green to measure speed’

2. When prompted press the blue button four times to see the menu.

3. Press the green button to confirm that you wish to record speed.

4. Position the LogIT Explorer facing a source of light, such as a torch. The window is usually sufficient on a bright day. The symbol in top left of the display will show a circle with a clear centre when the light level is sufficient.

5. Arrange for the object to pass between the LogIT Explorer and the light source.

6. The speed will be shown in metres per second.

7. The LogIT Explorer does not store the reading and therefore subsequent readings can be taken without resetting the LogIT Explorer.

8. To stop the session press the red button.

9. If the LogIT Explorer is connected to a computer, readings may be stored and processed.


There are several activities set out for you to try, listed on the next page.

Activities

1. P3
Heat light sound variation of light and temperature during day and night 
Examine Pupil Activity sheet 2. To obtain typical data open the file ‘Sunrise’ which you will find on the desktop. View the data in Graph mode. Use the magnifying glass to make the graph fit the screen. Try printing the graph.
Assume that the computer was switched on at midnight and the sensor was pointing out of the window. Questions to ask the pupils: 
What happens to the temperature of the room during the night? 
Describe the change in the light level during the experiment?
What happens to the temperature in the morning?
Can you think of a reason why this happens?
Help
Section G page 9

2. P3
Heat light sound 
Variation in temperature, light and sound in different locations 
Examine Pupil Activity sheet 4. Carry out the experiment.
Help Section C page 5
3. P3
Heat light sound 
Reflectivity of surfaces or colours.
Place a black plastic film can from which the bottom has been removed over the light sensor. (Make sure that the light sensor hole is not obscured by the blutack) Set up as shown below at an angle of about 45 degrees. Place the on a flat surface in not to bright sunlight. Let the film can rest on the paper. Use snapshot mode to take readings.


4. P3
 Heat, Light and Sound
Light intensity and distance 
Measure the brightness of a torch light at varying distances from the torch. Ensure that the Explorer is facing away from the window and/or use the film can to make the sensor more directional.  Use snapshot mode to record light at say 5cm intervals (At Level D when the pupils are more familiar with the Explorer pupils would be able to enter the distance into the data table.) Ask pupils to describe the pattern of the graph/draw conclusion.
Help section E page 7, point 10
5. P5
Materials
The rate of cooling of hot water in different containers.
See LogIT Explorer manual pages 49-51
Use two external temperature sensors.
Live mode.
Help section E page 8

6. Why do animals huddle
See LogIT Explorer manual pages 61-63
Use two external temperature sensors.
Live mode.
Help section E page 8

7. P3
Heat, Light & Sound
Measure the sound level at distances from a buzzer. 
Use snapshot mode to record sound at say 5cm intervals (At Level D when the pupils are more familiar with the Explorer pupils would be able to enter the distance into the data table.)
Ask pupils to describe the pattern of the graph/draw conclusion.
Help section D page 7, point 10

8. P4 
Materials/ Good Vibrations
Sound proofing
See LogIT Explorer manual pages 18 – 20
Connect the Explorer to the computer. Use a buzzer. Use snapshot mode.
Help section D page 7, point 10

LogIT Explorer Technical Stuff

· Maximum logging rate (3 sensors simultaneously) 100 per second.

· Maximum direct counting rate 200 per second.

· Maximum event timing resolution 10 milliseconds.

· AutoLog maximum rate 64 per second.

· AutoLog maximum readings 240 per sensor.

· AutoLog maximum experiments in memory 4.

· Periodic max 5000 readings

	Period
	Duration

	0.05 sec
	4 min

	1 sec
	83 min

	1 hour
	208 days


Setting the Level Parameters using the Managers Options.

The following are the default values.

	
	Decimal Points

	Level
	Sensors
	Timing

	1
	0
	1

	2
	1
	2

	3
	2
	3

	4
	3
	4


The dialogue box is accessed from the FILE menu, MANAGER and MANAGER OPTIONS

Speed  24
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Uncheck the Sound sensor information box
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Sound sensor information box is uncheck therefore only two lines are shown









